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Elements

5 Elements
i [ Data Archive
= (G Production Area

Mixing Tank]1

| General | Child Elernentsl Attributes |Port5 | Analyses | Version |

E| ﬂ Production Linel | Fiter £~ |
- (@ Mixdng Tank1 Mame ¢~| Value £33
- [ Storage Tankl
E| @ Production Line2 = [=] Asset Location Production Line 1
g :Err;!;er?rr;:zkz = =] Asset Name Mixing Tank1
(3}, Element Searches = =] Density 4321 gL
B =1 Diameter 5 ft
B % | ¥ External Temperature | 183.0364 °F
= | &7 Average 183.0364 °F
& E¥ | ¥ FlowRate 107.6311 S galfmin
= =] Height 10 ft
= =] Installation Date 12302014 2:00:00 AM
i [£] Manufacturer ACME
i (=] Serial Number BT498-C54
=& ‘ <F Internal Temperature | 198.8566 °F
= | <F Average 198.8566 °F
B & ‘ &F Level 2,273736 ft
| =] Maximum 10 ft
m =1 Minimum oft
-------- B % | =] Target 1591593 ft
o B | gF Level_Forecast 2.27373% ft
= =] Percentage Full 22, 7373600006104 %%
o B% | ¥ Pressure 57.58521 psi
& B [£] Product BCS1717
7 Elements = &% Status Filing
= Event Frames ¢ B2 K| ¢ Tank Status 2
i1 Library = [£] Tank Yolume 1468.797 US gal
e Unit of Measure
[ Analyses
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Production Line2 | Mixing Tank2

12/30/2014 8:00:00 AM Value Units

Name Value Units Trend Minimum Maximum Mixing Tank2|Diameter 3 ft

Mixing Tank1|internal Temperature  77.994 “F 31.404 240.91 Mixing Tank2|Product RX2451

Percentage Full
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L ! L MY 1P . L 20
1120/2016 9:54:36 PM 11212016 1:54:36 AM 10

]

68 I O| X| L (0] )



3.4 Pl Vision &7} 7|

3.4.1 PI Vision 420

o=

Cl2B30lo] A2, =8 w== o|ojx/of S0 YIS
A% e 4 ALICE 6405237} CH2 Pi Vision
Cl2B20] & 9/ o AO|ES 722 4 YL,
510 T2 2B 274613 ST SHo|HY AN HZD
Cl2B20| & & AOIER SA| 052 4 AL
HZE C|AZ 0|7} oo T YAt mEE AR

CI B2 0]2] XpAt O A7t HEAEQ RSO R
UR[SHA St SM0| Y Lict

s~ ooz Bllg sepst o8 02 Zay0)9) ot
20|Lt 226121 50| TY IS C|A B 0|0] X
27t 4 UBLCH HAE B2t SYLICE HA
Y50 YAE 57|54 M50 URLS Y BILICH

Format Text

Sync text to navigation link

Color [] v
Fill P v
Angle (e [0 ]

3.4.2 Pl Vision URL Oj7f 4=

URLES AFESIO| CH2 88 Z2A0|A T2 2 HA 22 Pl Vision [|AZ2[0|E &

O|¢|_| |:|..

AN H

URLS ALE05IH0] BtES de = AS LI

(@ osi-..

Hyperlink

Pl System /O/E] 7fA/3}

Add Navigation Link

Action m
@ Open hyperlink to another page
O Change context of current display

Search for displays...

Open in new tab
Setstart and end time

Set asset context

Use current asset
Use current asset as root

A
= T

69 | O| X|



Pl System L/O/Ef Z7fA|8f

o ST OHO[H OtO[H 22 RjTl T

=
=
URLS C|AZ20|9] A7 9IS XFT +& 9

ne
I

BoF= YA CAEY0|E RS
= | 742 ¥ Al(Ad Hoc)
ClAE0l2f LT,

o LCIASY 0| A2t HYE XI™ LT

o 71223 FEE X|FSY CHatd A Yol MiotE CIAZH0|E FLICH

o SYAFHEIZS SR CHE A0 7[E CIA S 0|2 ALBSIES 4 =
A& L|C},

e Pl Vision0| A M| ASH Pl ProcessBook & 4 AL C|AZ2|0|0f LSt @A S XS
= JAE L

o SZO|AE A|XRIO| A|ZFCHZL OFH, AFEXIZE X[ B A|ZLTHOI A HIOIHE 2 =
ALE CIAF 0[] AZHHE - 4= JUS LT

o LCIAEYO[OM =7 EZO0|Lt A2 BEAIZEE &7 AL, 25 54 = UELICH

o ZHIY HX|OM PI Visiong HASt= AFEXIL SR 2|C|AME[X| e S
ghLCt.

T3 2: Y ME(R)S Ao 2 F2| 2AHE D7 +5 e LIC.

(@)
= -

2
1A
o)
HU
>
o
m
rr
P
_\11_
Ral
C
Py
I
=
)
[
>
rr
_lj_
gjo
=
N
o>
-
in|

StartTime=<PI Time> % EndTime=<PI Time>

CIAZ20/2) ARt X B2 AIZHS XIFBLICL BE Q&8 PIAIZ HAS A S 4+
|

http://PISRV1/PIVision/#/Displays/339/MyDisplay?StartTime=*-1h&EndTime=*

Mode=Kiosk

7143 REZS X510 tiete & 0| Metel E[AS20]5 LIt

Of:
http://PISRV1PIVision/#/Displays/339/MyDisplay?mode=kiosk

—_— 4@ osi-.



http://pisrv1/coresight/#/Displays/339/MyDisplay?StartTime=*-1h&EndTime=*
http://pisrv1coresight/#/Displays/339/MyDisplay?mode=kiosk

Pl System /O/E] 7fA/3}

HideToolbar & HideTimebar
CIAZYO|0A =4 25 S A7 HEA|Z
of:

http://PISRV1/PIVision/#/Displays/339/MyDisplay?HideToolbar
http://PISRV1/P1Vision/#/Displays/339/MyDisplay?HideTimebar

Of2{et O/ H==5 CHE URL D71 Bl 271 AL S == ASLICE O &
5Lt

ﬂJ|0

= UL

™ Ch=at

fly

http://PISRV1/P1Vision/#/Displays/339/MyDisplay?mode=kiosk&HideToolbar&HideTimebar

>

L1

ISt W82 Pl Vision 247 2 Z2] ZEAQ| "EIAZ 0] EAIS MOog
e URL D745 HZSHA 2.

71 | O| X|

@



http://pisrv1/coresight/#/Displays/339/MyDisplay?HideToolbar
http://pisrv1/coresight/#/Displays/339/MyDisplay?HideTimebar
http://pisrv1/PIVision/#/Displays/339/MyDisplay?mode=kiosk&HideToolbar&HideTimebar
http://icons.mysitemyway.com/wp-content/gallery/black-white-pearls-icons-culture/024263-black-white-pearl-icon-culture-book3-open.png

Pl System L/O/Ef Z7fA|8f

343 X|H +=d &5 -URL Oj7iH= 2 SHO|HE A AL

o1 7HX| 7i'g & Ltefsts SAl0f,
s AAHAZA L

25
e URL Oj7f|H=E AFE235}0] PI Vision C|AZ2{0|0f CHet 213 BHE7|
=5 Add

=& "OoIM Mixing Tank10f OfH| SLEE 2T AF7HA| M7 AUt 25 OFF L
SagLCH E2 0] 7|2 St HIO[H S Al A=t OF gfL|Ct.

1EHA: =5 2& OjA/ 2 E <nitials> C|AZ2]|0| S ELCT.

2EHA: CIXIQI 2EZ SO{7tM O1R A QER x5 26t Zd 7S MEiL L

A &3 OefH S oA QERZ THEE SEot B g3 F=Ih . F HEgL T

ATHA:  CHE LO|X|2 sto|H YT G772 A Y2 A2 F0 C|AZeo] M. 23S
S LT <Initials>_Tank A7 &2 C|AE20|Z AL T

5T CIAZ20[E MY

6THA: IS HAELLLCL

7EA: CAESR01E 7|R2A3 REZ Moo 87| B8 2 AR LIt URLe £0f

&mode=KioskE F7tgrL|LC},

re ol (@ os]



Pl System /O/E] 7fA/3}

3.4.4 A& - Pl Vision C|AZ 0] ZF EFAY

25

g M Y0l tigt ot 2aE CHesh7] fls) 1
%

= o
o 0E SHUALICH AT XS MY XY 5 BRY ZR £8

o /N2 CHAIEEOIM O AbMISH C|AS20|2 2R &35 BEL

=M 29

Production Area Dashboard C|AZ2{|0]0| M Tank Dashboard C|AZ 20| 2 2 A HZdst2{ 0

st [_| [L

=

-

b EH
[ —]

1CHA:
2CHA:

3CHAL:

HiqA

ACHA:

5CHA:

WA QO HAIZE U Y3 8 (ABER SOk B3 MR FE T2 olof
gAE M2 KL

AR TS0 AHAES Hgdy & A= WA ME G E HOX|0f|A XpLh B

HOl&& ddgLCh

==

ClAZ2018 MYt 24 38 HAEY LD

o

OSI ) 73 1| O K|



Pl System L/O/Ef Z7fA|8f

4 C|AZH|0|E AF8SH0] ZENA 2L EFE

41 CHA|EE CJAZHO| A|ZH EA|7|

=8
o ME HOME ARSI HRE AlZ S0l
o ET MO I EH HEE HA|

Pl ProcessBook ¥ 352 PI ProcessBook C|AE2
ExcelO|L} & H2fRX E= ALVt Z2 CHE S agt o= ASLCt

Q.:I XEMIot L2 2 PI ProcessBook A/& & ZA72| "Pl ProcessBookO| A & = U=
A ZAULINN?"E HESHUAIL.

74 1| O| X|


http://icons.mysitemyway.com/wp-content/gallery/black-white-pearls-icons-culture/024263-black-white-pearl-icon-culture-book3-open.png

Pl System /O/E] 7fA/3}

Pl ProcessBook C|AZg0|2] 22 CtS 1t Z& L LT,

) . Steam Temp
Boiler Efficiency 37 % Boiler 954 Induced Draft Fans
To Turbine

48 ”\ Wal 0 30.4 To Stack
» { IM/GMJU \ ) Throtlle Temp 2 -' —
L] L L}
A \ ;. | =

28 L

Drum Pressure 233 psig

Drum Level 71 % Feedwater System R

Hot Reheat Press 387 psig

Hot Reheat Temp 477 DegF
Cold Reheat Press  10.3 psig w
Cold Reheat Temp 672 DegF T \ )

Air Pre-Heaters ‘—ﬁl\_/H
==

X
A
]

Condenser

[=

OSI ) 75 1| O[ X|




Pl System L/O/Ef Z7fA|8f

411 Ao =+dEs - HA[ZE0]A EIOE 27

& = MM HAIE 0f2f 74X HHE S THefets SAl,
xel2 K| A gLt

g
\d
Py
o
>
d
>
o
Ot
rlr
9

| ProcessBook C|AZ20]2F &4 PI ProcessBookOf| M2 =|= 02] 7HX| 7| s S
= 0|2 M4 E S

HT
2
M o

1EHA: 42| Xt=2| PI ProcessBook = 0f| Rl+= OSlsoft PowerCo.PIW It = HL|LCY,

2CHA: O] I E 2 Default(?|2) C|AE20| S| 0|X| 2 AH L,

ATHA: o 1709 CIAZY 0|2 o2 Salstc}
Boilerg

a M| 0|58 WAsIEHE HAIXI7} Lt & &Lt Gas Burer stalus ON
Gas Rate £69.3

STHA:  JhA E{LA AVERZE T ATEKQIX| SHOIgLIT

2 gro) [ ez zo5101 maay e clazao)2

HT
o

a.

A%
=

|CF.

6CHAl:  SOHHTH ¥2 EsLIts B8 28510 9 2y Jie To[X|=

SOt LIL,

o (@ osi-o.



Pl System /O/E] 7fA/3}

4.2 Pl ProcessBookOf|A PI Systemd]| ¢ &

e Pl ProcessBookO{| A Data Archive2}t2| ¢ =0l
e Data Archive0i| Ciot A A4 BH=7|
e Pl ProcessBookO| A AF MEO 4

o CIZE XA ZTYHES =0l
4.2.1 OfC|of AZg LTt
AF A|HE E9l| = =%l Pl System?| 0| O|Ef EE+= Data Archive2| QI E {|0|E & A& L CL.

4.2.2 Pl ProcessBook%|Al Data Archived| &4

Data Archive0f| CH$t A4S 2FQISEAHLE Pl ProcessBookH A A S M2 Z=7+SHe{H
O M| A8l OF FL|C}. PI ProcessBookO| A|&HEl AR Ci2E

Pl Connection Managerf
MERSEL| T,

File > Connections ...

2] PIProcessBook - [Pidemzl

7 File| Edit View Insert
] New...

— [ Open...
L3 |:T Cloze

[ save

Save As..,
Refresh

Page Setup...

Print Preview
Print...

Connections...

PI Systems...

Import...

. 1
[l =

OSlsofi. e




Pl System L/O/Ef Z7fA|8f

PI & #2/AF 0| LLEHH LICH &0 80 HZES 5= Q= Data Archive”t LIS € L|Ct,
Lot 7|12 AMHZE MEHSE Data Archive = HA|E L|C},

1 Pl System 88 ZE1HZ X3S AX|ot d20|= 7|2 Data Archive”} MEHE L|CH
[t2tA] Data ArchiveS T8 2F M 0| QICI2tE Pl Connection Manager®f| |2~ kLt O] 49| Data

Archive?| LIEFELICE,

—_

mlo

2 Data Archive0 CHsll €24 Qe AZ
He= AR E XA =3 9l Data ArchiveOf| CH ot
2 &= 2X[0f EAIELICE

Connections &0 A At 0|2 ¢ O| MEHE| st0l 2
LIEFRYLICE HZ0| O| RO T E% 7ty R8¢t &
(@] 7 =
T s}

HMAE {80t 2t

) Pl Connection Manager - |2 -
Server Tools View Help
= Server: PISRV1
Network Mode: PISRV
Port Number: BARD .,.
Default User Name: pidema
Connection timeout: secnnds
Data access timeout: seconds
Connected User: PISCHOO 'student(1 as piadmin, piadmins
Server |D: boebcel5-1987-4fc-8a36-2c583 e Jaacy
Connection Type: PI3 protocol 3.5
IP Address: 192.168.0.7
Pl Version: F13.4.395.64
Operating System: Windows NT AMDE4 6.29200
PISRV1 connected as PISCHOOL\student01 since 8/9/2015 11:02:15 PM Default Server: PISRWT

M7t gdst=s 220 w8

78 T 0| X| L (03 .



25

e Pl ProcessBook?| &4

=N A4y
AFO|EOA] AL HIO|HE Z35ts
Pl ProcessBook C|AZ2|0| & 4

22 P| ProcessBook A/& & ZA/9| "AH]

Pl System /O/E] 7fA/3}

Ol of Z4 Ml M

1=

mjo

Data Archive®| CH8t Al ar=7|
2] 7tX| 7HE 2 Lt st= SA0,
A X|HAEA ELICH
220 A Data Archive 27}
St= Ml Data ArchiveE 7532 0|2 ot & 7HX]
Aot 2 LCE O] 2[5l A= PI ProcessBook | Af O
SiiOF g LICt,

10
MO tiet A2 SEs =7t

Data Archive 0| &

HFEH
o -
1THA:
CHSH AH 04752 Aot
HS S 2
AHEEL|CH
2CHA: O]2{st MO A4
3CHA: O] AH{e] &4 Xt TH2

(@ osi....

Connections...> Pl Connection Managers AtE

5H0 Data ArchiveE £7t5t10
C2 X|EOo| e ER7t

|

OfL|2}H, 14 Sy LE

P25 P13 Bl 54502 2 R X|SFL|CH CHE MEH AFSR2 2| HA] A|AEIO

79 | O| X|


http://icons.mysitemyway.com/wp-content/gallery/black-white-pearls-icons-culture/024263-black-white-pearl-icon-culture-book3-open.png

Pl System L/O/Ef Z7fA|8f

Server Tools View Help
= Servc PISRYT

Connect as...

Change Password...

80 1| 0| X| @ OSISOft®



Pl System /O/E] 7fA/3}

4.2.4 Pl ProcessBookO|Al AF AH{ 0] HZA

AF ATH 0| M A =l GO H| O] A0 Al HIO|EE 7t 27| 28l Pl ProcessBookOf| A
CIAZSE0|E MA52{H Pl ProcessBook1f AF MHHQIO| HAZAS AALSHOfF & L|CH CI2 S
MEHSIO] HAE|0] U= AF AHE Zolgt o~ A& LT

= =T

File > PI Systems ...

D PI ProceszBook - [Pidemo
&M File| Edit View Insert

J J ME"N...
— = Open..
k ﬁ Close

= save

Save As...

Refresh

Page Setup...
Print Preview
Erint...

Conngctions...
PI Systems...

=0 M4 |
[ =

Import...

Select Database(H| O E{ #| O & &) THot A0 AZAE M7t ot H QBQI EELZ2 =50
G O] E{H| O] 27t
00| ’SOIEI(H %'t 87 017|01|E XFEOE cZgL IEf 7| E1|0|E1H1|0|*7f SR

2 A
M2 B YO HELID 22 AF HIO|EH 0|~ e = AS LT

81 | O| X|

@




Pl System L/O/Ef Z7fA|8f

1 New Database < Delete Database 3 Database Properties (5 Edit Security

Asset server: | Eadla AR

Databases:

Filter

MName

e Configuration

o 0&G Well Downtime Tracking-Full
00&3 Well Drilling and Completion-Full
@& ostsoft Plant

@ ossoft Plant EF

@ studento1-0SIsoft Plant

Description

A store for configuration data.

Development DB for Upstream O&G-Downti...
Development DE for O&G-Drilling and Compl...
Visualizing PI System Data 2015 without PI ...
Visualizing PI System Data 2015

CHE AF MH{O| AZASHHTH d=f 7|5 tha(L)E 2 25H0 THE AR MBS AR LT,

Select Database £

:"aAd.dAssetSewer ® Connect © SetasDefault [ Properties
[ Fter

Mame Host User

Description Default Database
wPISR'«'l PISRV1 PISCHOOL \student...

OSIsaft Plant

425 AF MHO| Ciot X4 TF HAt

Otz A= 24N AF Servers ZO|A AF MH{0)| Ciot M4 Xt ZSHS =fole

—

;lahddhssetﬂewer ® Connect @ Setas Default 250 Properties

Filter

Marme Host User
WPISF‘.'IJl PISEV1 PISCHOOL \student01 (Administrators | Studnets ...

82 1| 0| X| @ OSISOft®



Pl System L/ O/E] Z}A/Sf

@ OSl=ot. 83 HO| %]



Pl System L/O/Ef Z7fA|8f

426 K& ¢ 2= - AF Serverdf O3t A A4 oHE7|

022 0l & = MU0 MA[E o2 7HX] 7 E & Ttefot= SAl0f,
St THAE AN A s=dots A AS XHEA LI

2
e Pl ProcessBook2| X4 S 20| AF MH F=7}
=N A4y

AOIEO A Lt TIOIH S Z&dh= M AF MHE 152 M 0|5 it & 7HA|

Pl ProcessBook C|AZ2{0|E MA35t2{ 0 LTt 0|2 2|3 Al= PI ProcessBook | Al O]
ME{Of CHot 22 HE32 =78l 0F gL Ct

AF AlH| 0| &

g

15HA: Pl Systems...> Select Database S AHESH0] AF MH{E F=7tSt0 110 Ciot Af HAS

2HELICH
2CHAl: O] MH 0| AEZA=A HEA & == AS LI

3EAl: Ol ME{e] A& XA SE2 FAYLIIN?

a1 (@ osl:o.



Pl System /O/E] 7fA/3}

20| = %

L

=

4.3 Pl ProcessBook C|A

7 K
S ——— . o <
H joll :.___._._ = _._._0._| w
ol . N m._m._.n._ 20 3
Bl 7 e = m ; HB wr o
g =< 8 8 10 B O ol = m_r_ =
£ 5. 5. % @ T E o o
0 of g ’ ol | o8 i z O
uy = © K B . o K Ry
< & KK m K B o) 3
5 ] i " Sw | g 5o o 5
ol — " IR NE o = do H_uu o =K m
R A RERI 0 =< | @ of g
oo L ER ARESE o] oo = R g Wl
ml m_m %_ 4_ _._._._O u _.An_ " _I_H =< ml_ IT_A|
o U 0 Y o1 T+ or_o R0 gh TS
._m._nl A m 1E &w H_..Aum .Am K 1k . S T
T 2 = < K e & o7 i =
S | = | @ 2 og5 22
hPHv K M_ or 0 ~ ol =K Bl &w mM
5 3 - %0 S kio TR ol < 3
D T 2 iy "y . s <0 0 E A_l
g A 9 O < Al oF ol
s 83 = i =] 2 wjr = <+ = +p0 O
& 1 22 3 g H © S (@) o3 >
s S ——— g = RO ® 5 2
Koo () o0 8 = = 5 3
2z < T = Kl s = 3
© ol < agE=) o I KX
° 2 =) o i T o ol 1o J s
. = = . > 8
II__I |__O d o _._._._ —_ MmH_ m.An < O_l_ 0 o
= ofl = =] ™ LH 0 o X |
1o 0o ol (A Eo m_m o = x|_n_ wir |___
< oT 4 oo L TN W W
m ol - _ o u s D
= 1 Z o | 9 o ot o) &
=) jijS HM T4 £ Ll oo 0
¥ 3 T R Mmoo w o ¢ U ',
L o N A1 RO ol T o 2 M < Eb ﬂ RO q - Av
Ty A A g d ) E_quo_fw_m:_E
H_u m w 0 A_m m un_uu 0w _u__._ ﬂ ww WAo Wo "
2 ° ol 1 _
T a o | @ g | o ool WMk B W
._L|_0| W W_M ~ <k K & T H o T W oWMEF L




Pl System L/O/Ef Z7fA|8f

Z N0

1L

oh

<|

4
uj

ol

H

Of A gl LICE. et

= 205

A

IE A

- = 1T
= &4 =0l

A Af0] g LT 2f A A H T 0] A0

EMI=

-

u0
10
d|d

OF
0
oln

5

oI

RS R

=
=

(@ osi--.

86 | O| X|



Pl System /O/E] 7fA/3}

X

A AMOME QALETIES AL

gt
nE >
$0

SLCh
JHa=off &2810| EXHE CiMSHEH BE(*)E ALESHYAI (TS O X &x).
cd*158 = CDEP158, CDM158, CDT158
Ch= oflet 0] EAt SHLHRF CHM|SHA T 25 ARS St Al 2.
cd?158 = CDM158, CDT158
cd??158 = CDEP158

87 1| 0| X|

@




Pl System L/O/Ef Z7fA|8f

4.3.1 K& ¢ == - pata ArchiveO|A] PI Point 224

OlEZ2 O] & = MM MA[E 0] 7HA| i & Ltefst= SAl0f,
S 2o HAS AN AL Aot 2 Y S X[FHEA LI

ag
e Data ArchiveOf|A PI ZLQIE Z A
=X 43

Pl ProcessBookO| Al Pl Ef 1 HAAS AFESHY CHE HE20] ESHMAIL,

H
Im
=

=L L7t

rir

OSilsoft Plant2| Data Archive| Al E§ At A& ZOIE

88 1 0| | L (0]



Jd &

B File
(x]»

Pl System /O/E] 7fA/3}

REQXYBETE AL O
O 7hs &Lt

H

=
Q
[«

| Al
=

O
P

2JHX| BE

|-

—

x

EMA 2UHE OfA
A £

4

ClAS2 00 M 29| 37|2f ?X|

ClA~220f ZOotE 7|

Pl ProcessBook

EES
/|

.
O

Pl ProcessBook LH 0|
[ ]

441 H7|

4.4

2 O] Lo

Hin
<]

=~
= I

=
o
=)
o
®

A
T

|

Sk
o=
AH=
H=

X
]

O] ==0] gLIC}. O]

SHO] 7K S B CIAS2[0l0M 27| & 9IX[E =

=
=]

=

=
=

HEOAM o
L|Ct.

AL

I.

25t ™ Tools > Preferences... 0| A M| A == /= Pl ProcessBook Preferences &2

General 20| A Prefer Run Mode




Pl System L/O/Ef Z7fA|8f

ProcessBook Preferences

General | Table of Contents | Display Window | Trend | Trend Blements |

Authar

[ |

Startup File

|C:"-.F‘n:|g|am Files {2360PIPC Procbooken\PIDEMO.PIVW | | Browse...
Library File

|C:"-.F‘n:|g|am Files {<86)\PIPC\Procbook S YMLIBRY .PIW | | Browse...

Prefer Run Mode [ ] Create Backup Files

[ | Keep snapshot values on updating plots

. i T =

90 I O| X| L (0]



Pl System /0/E 7}A|2}
442 Bl HHA A|Z}

M PI ProcessBook It ¢S ddot2H It > MZ US7|S AHE0HL M2 2H57| Ot0| 25
A& UL

(" ProcessBook (. piw) File
() ProcessBook Entry
(®) ProcessBook Display (. pdi) File

Display Mame:

| MyFirstDisplay|

| oK | | Cancel | | Help |

7 PI ProcessBook C|AE2{0|E M d5t2{™ ProcessBook C| A Z8|0|(.pdi)2| OFX[E S M S
MEHSHL|CH A PI ProcessBook C|AE 2| 0](.pdi):

e Pl ProcessBookOi| A Cf|O|E{ o] 2| HMIE| 0|

fjo

&4 dot

7|

L

rr

CHe LT

o =HHOZE ME(pdi EE .svg)2 =& UL Pl ProcessBook(.piw)2| YFE AELY =5
o
AN

AAO| | O|E{ # 0t OfL|2t PI System@| A A|ZH M4t HIO|E E At83SH= 2Y

= &|

LtEfL = Ol Ar8 El= 2= 20| Z& & JASLICE

o EDHCHE PI ProcessBook, CHE PI ProcessBook?| E|A S0 £ 7|EF &
D20 HET 2~ Q& L|C)

T Mmd

4.43 Pl ProcessBook0A Z2ZMAE ZLEHPSH| 9ot C[AZ0] dd

91 | 0| X|




Pl System L/O/Ef Z7fA|8f

ChE= A AL RIE T2 M|A| &= CFE Pl ProcessBookO|LE C|AE 20| 22 CHE 88
T2 10| Chot A3 E W YSh= O AFSELICE ot TS ARSI AR ES MY
UAE LT

&8 & =2 PI ProcessBook C|AZ2|0|0|AM HA|ZHHOIHE E= O AHEE = U=
MEYLICH 0]243t M =2 PI ProcessBookO| Pl ServerOf| A H0|EE 2o HA|ZIC 2
YHOIEELICE FE ARRE= R 7K 88 =2 Cadt 25U

o O Ty lul
. ai. 123

M d=28 0230 Fotoks d20l= BA 227 =+ 25 £= A2[7]| EELR
HroM 2 S S2gUML 35 422 UESHH 0L Lo Y= 222

2 S0 & A= M =2 712 T2 28015 22510 ZHE T AAZHO|
MAEST 0f7|0f A2S 2 4 UBLITH OhRA EIEE 00 Uots 55 942 Ho|3
7 A= HO| LIEFE LT,

S5 42Ol WOl ZYEIE B2 UE [ rgsma 2] |

Fof mef G EXT 2E 35 dE2 82 Tag Search

H=0| HI0[EZ 71 = PI Server X H| 0| & Sutn Fnce] PI Calc

Oto| 2 X|'Z3H{OF 2 LICt. ODBCE M| 2|5t1 ODBC

Of2{et = H|O|Ef Ot0| " HAY 540 CH AF2

& Of% l—| Ef Logarithmic Element Relative

92 H|0| X| Lﬂ (0]



Pl System /0/E 7}A|2}
ClAE20] 44

ZHX 7HE S T 3f SAlof,

=5 49

Production Line22| Mixing Tank20{| CHo == A& FH42 ZLEHASH| ¢/t

Pl ProcessBook C|A~Z2]|0[ & d-ddta{n gfL|C} O] 0= O|2{et S84k, siie P ZQIE 3
Pl ProcessBook C|AE20]0] Zatet AZ= 58 H=Z0| L E & LTt

S™E U HEE p1 2O =X A2

N

=

|c_cs e 25 VPSD.OSiIsoftPlant.PL2.MXTK2.Internal Temperature A

c

= | &= VPSD.OSlIsoftPlant.PL2.MXTK2.Pressure Edc

=

0| VPSD.OSilsoftPlant.PL2.MXTK2.Level E2iE Hf

SIE: LOIE HMOl= dFAE AFEELICL

0
I

ACHAl: Pl ProcessBook & =212 HLICE A Pl ProcessBook C|AZ2{0| ot

S5EHA:  AYREQIX| =olgti|ct,

6ot Eaic ot B 2 22181241t praw(32]7]) > Trend(EHE)S MedstL| ),

— 1

93 | O X|




Pl System L/O/Ef Z7fA|8f

TCHA: E-EO| ARE S 2 &K} SHLEE I8 LICEH Define Trend(E™E FQ|) 0| E2|H
Tag Search(Ei1 HA)E S =5t = HO|H 5! &3 2 IS HY5t=
ZOIEE XLt
a. Point Mask: *Pressure*
Descriptor: *Mixing Tank2*
c. (Ole 2B E|D ZMS Al 22))
d. Point Mask: *Level*
e. Descriptor: *Mixing Tank2*
8CHAl:  EQIEEZ MEISID OkE SEEYLCHL OHE B E EME 82 7[24UC2
SX|BLIC
OFtA: ERME HOf| Hof D= E =I5t A0 +=2|F HAIL|C 0| ?IShM = Ht
ctz= il £ 2251741t praw(22]7]) -> Bar(Hh S ME St LI
100HA: 7t ok [E = s28i0) e o) L8 25 2t 27t Lct
42.3033
8/14/2015 3:35.33 PM 8/14/2015 11:35:33 PM
94 1| O X|

@ OSl:oft.



Pl System /O/E] 7fA/3}

2O 4

5 = m
_ ~ O] =
— o =< O
ol o Ox i =
< n O o)
10 Q L- = o
oF s ™ <1 Al
~ S g o a
o o g 0f0 5&
i oF £ i U = me
i L H <o N =
iy < & oo | & | T N
RO & oo W | & = | = Rr
7 ~— [} —
i} = K= oF U] 5| & )
Kk N ol <] R0 b N 70
m K- R0 wl ol KR Kir
= of B B X W wowo | <k | <k | RS ht
= A_I <a _._._.__| =) ._IOr OA
= ol T IH ™ X
S o S K <
Ml_ = il 0 3H ol . =
T X ) <F zo Hn NS &
2 e Bl AT < | m =S
B o LT g RO )
KO Hu - 0z o | KF | ¥ | o i
S S J - 0 oy | of —
S o =) . O g dr S
ul AL o 0| IF | F | @ T o=
ol < 0 ol i 2 = = A L A KR
{1 < 20 A i % o 2 of | = | @ | o0 | = 3
<M o)y & = o - ro AT
oo o > o ._Lmu - 10 % Tue] Buixin = O%
o RO =2 TR =) — e s up <k
i = ™z N o I3 9AIY2.Y eled L
<I o = i <] R
- oLl A WS =) _ﬂ o
T o - © <H
RS z H -
0y o T ..
_nﬂ_ ® o = - —_ |_I__||_ =
< o< f @ Y N
AN

or

o
[

T O 8 10




Pl System L/O/Ef Z7fA|8f

3Tl Y= ot 22 Y30 tot L2220l ddReLz, O|N BHE =& Y30 tfsh

(@]
2fLICH SEO 674 Ol 28 Y37 UM 4
=28 A0 tier CjAZ2 0[S ddsKof ot

96 | O| X|



Pl System /O/E] 7fA/3}

ASYO[Of|lA] HEl LI &2 FARILIZ?

MAlE o2 7] 78 & Ttefst= SAI,
A= A gS XAHALA L.

25

e Pl ProcessBook C|AEd0|7t S&20tX| H7t

=N 49
Ya HEALZ2MAE 2L
A

E =
ClAS20l= 2 AR O e B2 oM 2R A =elegt C|AS2|0[Y LTt

= —Td

oE 1

ClAS20]0f Jots 2& WEO| 2| ALt S22 A L|7t?

O oMol o2 UM T2 M2t FASH] O] C|AZ2 00 =7t &= 7Y

o o

rlo

El

tE

w

Of C|AZg|olof F=ote 7B §2 8 7 &0 ¢f2 FAYLITIN?

(@ osi...



Pl System L/O/Ef Z7fA|8f

M=Z = gl
7_}{48} A|7*§f lee Mg IEf AF Display BuilderE AFE5IH AF 24 A5 X @4 542
st

Eot A E= QA HES ME22 Y =5 JUSLICE 0l
o[0] FAEIOf A ABE HAIBE + 2
451 AF H El-ox-l ol AF AA‘I View| Insert Tools Draw Arrange

AF Display Builder =7} 7|50 A= Pl ProcessBook LH0f =gt == S —
U= CHS 27K 22 &S AHE R . Zoom..

Layers...
. AF H2ISX: GIZE AF M LI0| AF 24 A5 A0

AFBALE A5 LJOJM ZMS $335l0] EH R4S 82 &
A&LICh

o AFHZEAF E2RN0| HEE 40 @4 E42 BAIR L.
JI2HMCR AF EE0= 24 S} EL

Trend Zoom 4

Assign Shortcuts

Sde= 0|5 & ¢t 0 .
E View Status Bar
HA|E X0t AF EAL O szg_;z o m=oloM B ojoj=e @ Full Screen a1
L Contacts
%é! Ol-o:l AE-'%‘, |:|_|_, UoM | —DIS7|’ %1% jiAl?El- _)I\_ %Ikﬁl—l EI-- MNotifications

Data Favorites

2{ ot &2 Pl ProcessBook 3& 213 LHO| OfFH {IX[O|ME =&, [ aFproperty
A 9 DA SR E AL XY 4 QI OH, AFEAHE B A Browser
A

= =
E20[7F e UK A2 HEHOM = AF R4 MY =

Element Relative Display

I:l O 1=
O A | I.
A H I_' E
) PIProcessBook - [Displayl] o )
BB Fle Edit View Inset Tools Draw Arrange Window Help _8 x
LDed &R @ & B wx -~ 88O a #»r K
APINODHOrEE Y+ L uE % B & EE T
12/31/2014 »
7D -
AF Browser v x
T 0Slsoft Plant - [==
[ »-18
Update Symbols
& Bemerts
- (@ Equpment Mairtenance
= @ Production Area
=i @ Production Line
-8 St AF Browser docking window
v (3 Storage Tank1
S @ Production Line2
i (@ Modng Tank2

- Siorage Tank2

AF Property docking window

+

Group by: (7] Category [~ Template

!
[a= 5~
[+ m/&/pame 2 Ve Time Stamp Ut OF Measure Data Reference AE

= o ®

13398329 F 1/2/20159.16:13 AM degree Fahrenheit Pl Poirtt r
L] 6561616 gom 1/2/20153:16:13 AM Gallons per minute Pl Poirt
s @ | F intemal Temperature 56.64317 °F 1/2/20159:16:13 AM degree Fahrenheit Pl Poirt.
L & Level 3890527 m 1/2/2015 9:16:13 AM meter #I Port
H =
g

a2 =] Percentage Full 4863159 % 1/2/2015 9:16:13 AM percent Fomula



Pl System /O/E] 7fA/3}

=X

— Pl ProcessBookO| A AF A&

(<] =1 L=
S =0

A
e

452 X|&

AN AL Aot 2 g s X[FHEA ELIE.

=
=

A

o

Qls
=&

o

H
oir

A3

o
[

IS A2, O] 22 OSlsoft Plant

HIO[EH| O]~ S AFESHY 7| = LICE.

—
|
E]

12 OrL?

ot
= |

S|

Mixing Tank22]

(V]
|
E]

(40}
|
E]

75 0|2 L7t

TR 2=

H.O=|

Storage Tank22]

|L| 7t

=
=)
=
D
(o]




Pl System L/O/Ef Z7fA|8f

4.5.3 Pl ProcessBook C|AE 0|2 AFE

AF Display Builder 7} 7| 5

o
MEELICH AF £ oM 545 B3a 20

100 H|O| X|

\



Pl System /O/E] 7fA/3}

—L

45.4 A Metst7| - Pl ProcessBook C|AEH 0| E MM35H7| et AF 54 S0}

offr

7|

o1 7HX| 7i'g & Ltefsts SAl0f,
s AAHAEA Lo

25

o AFSJES AECSIO] L|AZd|0] 257

=N 49

Pl ProcessBookOf| A 117 2A|7F S99 Mixing Tank12| LHE U Q2 2 E HOFE=
EHERL SN A X ENME HO{F= 0] et E C|AE2 0| g5t axt gLICt Data
Archivel| A|ot AbetS QIX|StD O] CAEY0|E HH S U AF S8S AHESH X} 2L T}

HfEH
o=

1THA: Pl ProcessBook & Z= 12 GL|Ct A PI ProcessBook C|AEd0] ot

*pdis d-dgrL ot
2CHAl:  AYREQIX| =felgtL|Ct,
3CHAl: AF HEtRKX U AF 4 ES OtA] S oStA| AUCHH 2 atet Lt
ATHA:  Trend tH=E 2 &5t L} Draw >TrendS MEHBFLILCE,

S5CHAl:  EEO| AMEE 2 YAt otLtS g LG ER-ME Fof 0| E2|H A%
6CHAl: AR 22t X 0| M Mixing Tank12 EECH25H0 S 2L,
THA AR SE0AM EY AR 255 HEo S B EMER SO SSLCE LR

8EMAl: AF HJ0M S8 2X R
X0 EAHL S5 L

Lﬂ OSlsoft. 101 H[0|

i
>~
L
ot

o

S Pl ProcessBook C|AZ2{0|2] &st=




Pl System L/O/Ef Z7fA|8f

102 H|O| X| @ OSISOfB



Pl System /O/E] 7fA/3}

K| 7+
LI} Of 22 FX|

AFOf| 148l @4

o

—

Pl ProcessBook

<
=)
. El
T ')
T N S
Al ﬂka
i = b
- 4l 2
<0 — <
11— LI._A jo
o _ i w_o ol <k {0 o= oL o
Kiu & = LIAm_._._ﬂEIA w o <q
7l HWU_I [ o = o< <= o Q:_ .
ofu il o _m__.__z < ) X o il <+ - Hn =T _m @ 0 U
N i L e ! o A= o5
My < A|_Mo o 1 ¢ E“ % 9og > (4] " om [
Tx wd < IS e I omm T ooy I h
K | T <= Uy . e | — Ao @ K
=B 2w WK oo R o <l I N
oF 90 < @2 Ay o 0 _._m_ a2 g
0 g D o o g T w0 < ! o T oo
L 3 ol ol o5 J K L AT TRy
~ N Mﬁﬂfﬂ a 243 T U =
E3 R 0 R ! D
ol = Wﬂo_|e_em_.._H._lo_ w o > = Noan I 3L
x O 0 RO = = — <X Al = W ] EL
S w_mwaxzaww R R § 77 Uy
= [¢) o |_MOLI. — J0 = i o on B T =
Q0 m = 09 U o K 0 -4 2 g @ 30
0z R 1) o " oz o 2 oo
s < = =K w_m o 10 |7 _.___H_ 1l i} S Lo 2 & |8 4 o @:A_ =
S o oy - R % o H 1O B8 < 14 - ol oy 4
a Sy W m < O, mE W = e 5 o U =
o oK 7=_|._|L| _|_._"||__| n m O o c i _u.__.ﬂ o
o o S 0O — o 2 = - o i mu 2 [H] < e
- 0 &7 3 W5 S ol £ o o0
T3 H E_ghmm 4 o og@ - o T om
T < ||L||_+o_|_x = it i T
= m o 2 & ol O R o =z £ = i e
Gl & H e _”_._MH_DE_E s = S & T oo
_.T_mm ___o_nHOrEE Hxéwﬂ_l.ﬂ < E_DE H=T__AE m_U|+_m__+”_|r__|. i e
= H oo, o o_EM|.ro S )\ = - I
ofg ™ :;o_HL% =] = J K ~ A = T
Hiu 1 oy © g O <020 = S w ~3 S =
ol T0 ol o N = N o
m <l F o WO o U gy H o I ™ ™ o M o3 ™
= - H Kl D o g = D Hr o
._|o_l_ . ||__._uo__._._ Ol_wmll_ 0 S WA_ <
oAy o M = gmﬁaALOH & 3 3 =
AO||__||EOW_H_._M o_L|_u_E ~ S S SO . <y
_ | T KO E_”_._l_/ o o = m = = A
S BTy < ol <02 S a9 I L]
= 10 (| S & i x||._1 ) L ™ ~d
IJ.HL|MM M7_|_/ﬁ_/ E__| _n__I__A T o .- ~
i T3 < - - ~ T 8 =
<A T AT A% & m 3 e o d
[ I35 AL 7 oo K{ <1 e =
S oo @4 | < K = <
Bl o oIS Z0 < =R T o o8
< or 7 O TR X
o_%uxu_%uiwn
ot H R




2P BAE f4 TAS AASE Pl EOIES

Pl System L/O/Ef Z7fA|8f
ol2

-

joll
il
mn
o
o
Tl

M 22 Folof HIolH ofo|@ ez T LT,

=
=]

]|

9

H[O[E OtO]

—

—

LB A

UOM:

X gahof

=
=

TN A

|.

0

L|C}. AFQ|

L|Ct. PI ProcessBook 2012 O]

Of7i S =7t6 = gL Ct

3

.
o
=

S HA|

Pl Z QI E 2| EngUnits

74 "kpa'el 2o

3

=

o
o

K-
g

4

UG LIEE A

AL
T

L

S
=

(@ osi--.

L|Ct.

8

=

-
o

X 240|022 CIAZH Ol =7t
Al

4

—

.
O

104 I O| X|



Pl System /O/E] 7fA/3}
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Current Element of Interest:
(F Storage Tank2

Attributes for the selected element:

2| ¢ || Name | Value @ |~
7 E [&7 Level_Forecast TAZ160ET
= =] Percentage Full 15.8930611610413 %
¢ B | &F Pressure 51.6722 psi
& B =1 Product HC15000
B |7 Status Filing -
s BB ¢ Tank Status -
Bt £] Tank Volume v

Selected Aftributes:

Attribute Uom
Exdemal Temperature degree Celsius

| dd Element Name |
[] Use Full Path

leelvin

degree Fahrenheit |

degree Rankine
Celsiuz

oK || Cancel || Help |
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Pressure (KPa)

P
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Settings
AF MH{Z E3 =Z5I p| System?| 50| Ef = Data Archive®| ZQIE Hjo|EjE T About
K25 L|Ch Pl DataLink0l| Af O[2{3t & HIHS B LZ0| A A AL © Help
Connection Manager0Of| A 22| 2FL|C}.

Connection ManagerE €™ 0|0 Z=7}Z|0| Q= Data Archive X AF AM{H| =55 0| EA|& LT},
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i) Add Asset Server ¥ Add Data Server Connect @ Setas Default 7% Properties @‘Buﬂ“ering Manager || Refresh
Filter

p |
Mame Host Lzer Buffer Status Description Type Default C
B pIsRv1  PISRVL PISCHOOL \studentd 1 {piadmin | piadmi... Mot Running Data Server

l:IWF‘ISFU.-'I PISRV1 PISCHOOL \student 1 {Administrators | ...

Asset Server OSIsoftF

£ m >

Buffer status update is complete.
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Filters [] = Dataitem Description
= OWPISEVTVOSIsoft Plant PLZ STTEZ Inter...  Intemal Temperature of Stor
Descriptor W El WPISRVINDSIsoftPlart PL2.STTHZ2 Bte...  Bdemal Temperature of Stor
- =] WWPISEVINOSIsoft Plart PLZ MXTEZ Inte...  Intemal Temperature of Store
=l WPISEVINOSIsoftPlart PL2 MXTKZ2 BExt...  Estemal Temperature of Stor
Paint class W =1 SWPISEVTWOSIsoftPlant. PL1.STTK L Inter...  Intemal Temperature of Modr
- El “WPISRV1MDSIsoftPlart. PL1.STTK1 Bxte... Exdemal Temperaturs of Mix
=] “WPISEVTWOSlsoftPlant PLT.MXTK Inte...  Intemal Temperature of Modr
) =1 WPISEVINOSIsoft Plant PLT.MXTK1.Ed...  Extemal Temperature of Muxi
Poirt source W — )
El WPISRVTWOSIDEMO _Well 32 Tubing te...
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|“lernp‘

| [8] %I

@ Production Area Data item

WPISRYIMOSIsoft PlantProduction Area“Production Line 1\Miing Tank 1|Density
WWPISRYIVOSsoft PlantProduction Area®Production Line1\Mixing Tank 1IDiameter
WPISRYIVOSIsoft PlantProduction Area“Production Line 1\Mixing Tank 1|Extemal Temperat...
WPISEY1WOSIsoft Plant™Production Areg™Production Line 1%\Mixing Tank 11Btemal Temperat...
WPISEY1WOSIsoft Plant™Production Areg™Production Line 1%\Mixing Tank 11Btemal Temperat...
WWPISEY1WOSIsoft PlantProduction Areg™Production Line 1% Mixing Tank 11Bdemal Temperat. ..
“WWPISEY1W0SIsoft PlantProduction Areg™Production Line 1% Mixing Tank 1iFlow Rate
“WWPISEY1WOSIsoft PlantProduction Area™Production Line 1%Mixing Tank 1IHeight
“WPISEY1WOSlsoft PlantProduction Area™Production Line 1" Mixing Tank 1linstallation Date
“WPISEY1WOSIsoft PlantProduction Areg™Production Line 1% Mixing Tank 1linstallation DatelM...

Description

over the last hour
over the last hour
over the last hour
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Compressed and Timed Data
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*
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45

40
1:00 PM 1:30 PM 2:00 PM 2:30 PM 3:00 PM

Time

—o—Mixing Tank1 - Compressed -#—Mixing Tank2 - Compressed —-+—Mixing Tank2 - Timed
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EE S Mixing Tank12| 2| 2= 0f Cisl OF70|E & 10| = EfYAR = Mixing Tank1 1}
Mixing Tank2E H| W &0 X of LT,

1EHA: Microsoft Excel| A A A1, A3, A4 B! B50{| ZfZt T|O|Ef OFO| &l A|RF A|ZL & A|ZH

2CHA: HAAMES AFESHO Mixing Tankl 2 Mixing Tank22| 2|2 2= EMS &1 M1 3

=
B20f Z{Z @& LICf.

o
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0| &t=2 PI DataLink0| 2t =¢t%|= Zd2 OtL| X|2t, Microsoft Excel0f = ALtA2+R10| P19

BHO| gl AlHet 7|55 WaA F=te + gLt 2n3erel2 An3.:etel

HA[ZEHH[O] S 2l
Ao Y IO HE o ASLICE Hi €5 BAISHE o2 g0 =0 MY P4 =
X gots =7t 40| AU
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AehBHLICE GlOJE] H9I0) Al BIOEf 7} EatEl WS MEBHLICHERY A IS F|QISt et AleH).
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Line Column Win/

Loss
Type

Compressed data

NWWWY

Mixing Tank1 Mix

21-Mov-16 00:00:00 0.162766

21-Nov-16 00:00:35 0.345072

21-Mov-16 00:01:10 0.313422

21-Mov-16 00:01:45 0.712886
21-Mov-16 00:02:20 1.176302

TI-Mow 1A MN-NT-55 0 1 A172AR
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5.7 892 23H p| DataLink 211 A]

X

Pl DataLinkO| A= PI DataLink 211

= 2t Pl DataLink 22 ME £ A
AMeh = QUELICH 0] 7|52 AAME Soff K| =

—
o| 22|00 2 £ & st Microsoft Excel

HOHE 482 + ASHC

= T AM-d

=

1 |"\\PISRV1‘\DSwat Plant\Production Area\Production Line1\Mixing Tank1 E

WRISEVT1OSIsoft Plant\Production Area'\Production Line1'WMixing Tank1
WRISEVTWOSIsoft Plant\Production Area'Production Line1yStorage Tankl
WPRISEVTWOSIsoft Plant\Production Area'\Production Line2W\Mixing Tank2
WRISEVT\OSIsoft Plant\Production Area\Production Line2\5torage Tank2

5 |Flow Rate
& |Height
7 |Installation Date

Data item length Insert oot paths in:
{] @® Drop-down list
Full path ame only O Column or row
’ oK ] l Cancel
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2CHAl: Pl DataLink-Exercises_<Af&Af O/L] &> xisx I 2| Operational Start Up A|E 0

MBS g=ale gLt

EHA: s Mot Hlng [ 2= S S H|0|E2| Pl DataLink &5 25 AFEEILICY.
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5.8 Pl DataLink®| H|<

=g

o HIEES A7 ZHEOL Y A7 E EHHS LT

o HIZEO AV =T W HY YRS LIH LT
5.8.1 H{E 37| =F A7 Microsoft Excel -
Pl DataLink X'”%% Al"g'-é*[l‘ EE Af%ﬂ’% Z.C?_Z.Cf_ l\ You cannot change part of an array.

Ofefjet &2 HAIX[E EA ELICh

Was this information helpful?

Yo 28OS A s HM2 o S YA To B E S Eretef Lt O HIE2 EH =2
TdY = QXT TN B E2 =3 = ASLICE Ol2fet g2 AFg el ZRIE, A g Al
Heletolel 8 &5 AYs V|Hez AVt HEE & UASLCH W2tA B8l BilgS
oot g E2 = st

210l 2 &g A2, U Y SIEH0| “Resize to show all values(2E 42 HEA|SIEE 37|
Z7d)"0|2t= M AIX| 7t LEEFE LT,
Hi Y 37|18 =HSH= 7t ¢l W

o
(Resize) Function(gfs= MAAHE 7| 2H))S MEISH= A YLICH

Calibi ~[11 ~|A & $ -~ % » &
28-Jun-1619:02:57 59.77 B [ = - A - G- 40 80 o
-16 19:07:57 59.3300

Select Datalink Function

Recalculate (Resize) Function

28-Jun-16 19:27:57 58.20 5ampled Data...
28-Jun-16 19:32:57 58.79 ¥, Cut
28-Jun-1619:37:57 59.45 g
28-Jun-16 19:42:57 61.67 . ,
3 Paste Options:
28-Jun-16 19:47:57 53.60 -
28-Jun-16 19:52:57 58, 0

A lom 18 10-E7-57 KO S0 ~ . .
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Properties Update
Prupeniew
L} Z =l Data Item(H| O E{ OFO|EN)Of| Th2} Of 21 Properties(Z4)7t EA|ELICH PI ZQIEQ AF
£4d 25| £ thel= Pl Datalink £ 5= 0l UOMR 2 HA|E LT
Data Archive AF Server
) L - X -
Properties Properties v X
Root path (optional)
| | Foot path (optional)
Diata item(s) | |
Diata item(s)
["“WPISRVT\SINUSOID |
< [\WPISRVT\OSlsct Plant\P1| [ Q]
Property
» IEI Property
archiving - W Ig'
changedate categories
changer description
compdeveng Lom
compdevpercent ipoint
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COmpmin OK | | Apply
compressing
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6.1.2 A& 2to|=zZ

Pl ProcessBook2| &/ & 2t0|E.2{2[0jA 0f2{ O|0[X|Z MHEig 4=
U LICL Draw(Z2/7)) > Symbol Library( /= 20/E 2/2/0{| A O]

21022 2]0f M ASF7LE, HlR0IA A2 2toj2 22| ojo|2 Bl & 22/st0f o] 2to|22{2|of
MM AT 4= USLICE

|% Symbal Library |

O &= 2fo|ER2|2 B 4%, I O|0[X|E 7S =& U

=
Graphic(—Z2f/Z)S Ar&st0] e d oS o YetLtt 0|Z &3l 4
AP 2 9l |}

T Mg

=L LY, Draw(jE/7/) >
M2 AMEALAE 582

6.1.3 HE-AHOIEME

U MZL SX 0| 242 7|02 MAIS WS £ Qe HE|AHO|E THS
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6.1.4 XA =¥ &5 - P| ProcessBook?2| Xt

r
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e Pl ProcessBook CIAEH0[0 M &= 7t
=N A4y

PI ProcessBookS B3 BE2 ALSL0] HE A2, 42 210|22{2|2 Sof BUEO| R4S
2UYstD BE-AHO|E HAS HBHIAlL.
2

15 A CIAZ201S YaBtLC,

2EHA: o= 2tol2e2(e B2 S FIHELIC

Symbol Library - Boiler with flames \ X |

Categories: E F
ASHRAE Controls 8 Equipm =

ASHRAE Ducts |

ASHRAE Piping m
Basic Shapes —
Blowers Etc.

Bailers

Buildings
Chemical

Computer Hardware

I
_ g
@
=

[ OK ] [ Cancel ] [ Options ]
o " L= — = " o - o Arrange| Window Help
3tHAl: A, BAMY = IOio| 52| OHE X o=S F7/retL Align >
Forward
ATHAl: B Dl HIE AFRSI0] RIANS Q|2 LIt R Backvard

T3 Bring To Front

BY Send To Back
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5CHA:

6CHA:

o BA
State Info
Mumber of States:
2 -
State:

Values:

<= | 100,00000

Color for Bad Data:

&
[ Blink

Color:

1

Blink

o710 ZhEhet off 7t Lief Rla L Tt
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1wl Installation Date:
MIXIng Tank1 12/30/2014 8:00:00 AM
Pressure (KPa)
S - T

98.5876

Temperature Inside & Outside

Bd

180

140
120
L0

Product:
BCS1717

5172017 2:10:33.62265 AM 51172017 10:10:33.62265 AM

Diameter (ft):
5
1vi Installation Date:
MIXIng Tank1 12/30/2014 8:00:00 AM
Pressure (KPa)
Flow Rate (US gpm) _ 400 600 800 103421
96.4709

Temperature Inside & Outside

180

440
120

Product:
BCS1717

51172017 4:47:04.927 AM 51172017 12:47:04.927 PM

Diameter (ft):
5
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6.2.1 X|& =3 &5 - Pl ProcessBook H|O|E{0f Ci$t LA EM

OHEZ2 O] & = HUoM MAl= 6] 7kX] 7' & Ltefste SA0f,
S HAS AN ZAE dots S X2 E L.

25
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» Database OSlsoft Plant

» Time Range Timebar Duration

» Event Severity

» Event Name

» Event Type and Atiribute Value

» Asset Name Assets on Display

» Asset Type

» Event State

» Event Category

» Event Acknowledgment

» Event Comments
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» Number Of Results
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Downtime-Mixing Tank2_2016-06-14 16:59:35__.
6/14/2016 4:59:35 PM - 6/14/2016 5:39:53 PM
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Downtime-Mixing Tank2_2016-06-14 16:59:35.000

= Maximum External Temperature: 43.731 °F
= Maximum Internal Temperature: 55.642 °F
= Reason Code: 3

= Temperature Difference: -8.2101 delta °F
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Downtime-Mixing Tank2_21 i
6/14/2016 4:59:35 PM - 6/14/ App[y%?me ELIE

Event Details

Downtime-Mixing Tank2_2
Compare Similar Events

7.1.2 OHIE & HE IFtXH27|

O/HE M7 F=ZS

= (e}

> >
n

Jot

Pk
-

o
ot

190 H|O| X|

Ju
Ot
m

\

T O[HES| A[ZE e

MERSHH O E0] Ciot HE 7t U= EUMESL}H|O|[Z0| BHSO0{X|H, OIO|H S
HEO F7FE 4 ASLICH LEZ0| e oM EC} IR THe) U FA0)
0| QS 435t AH0| Y B O[HIE T of A FAS F7ket D OMIE TS
7= AG L O] AM A= PI System ExplorerOf A =41 2| Hote 2 H|OfE LT
Downtime-Mixing Tank2_2016-11-20 23:47:32
e Apply Time Range
| Down 01
Event Details
| Down @T‘ :30._.
Compare Similar Events By e
Compare Similar Events By Type



Pl System /O/E] 7fA/3}
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«# Automatically refresh the list £300

#* Pinned

iime-Mixing Tank1_2017-05-06 22:47:27.000
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| ' Downtime-Mixing Tank1_2017-05"0004d

Search Results

| * Downtime-Storage Tank2_2017-05-11 17:49:37.C.
| ¥ Downtime-Storage Tank1_2017-05-11 17:48:06.0.

1 2 Downtime-Mixing ' 2017-05-11 14:48:49.000

| © Downtime-Storag

1 © Downtime-Storage H | d d en Eve nt
O Edit Search Criteria | | B8

Attributes

Downtime-Storage Tank2_2017-05-11 15:48:47.000
[=] Event Duration (minutes): 13.533 min

Lost Production (gal): 1,964.7 US gal
[=] Maximum External Temperature: 266.2 °F Downtime-Mixing Tank1_2017-05-06 22:47:27.000
=] Maximum Internal Temperature: 193.81 °F Downtime-Mixing Tank1_2017-05-06 21:47:36.000

=] Reason Code: Maintenance E3 Downnme-smaae Tank2_2017-05-11 17:49:37.000

l I elta °F V' Downtime-Storage Tank1_2017-05-11 17:48:06.000
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Conversion factor U
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Time-weighted total calculations require values recorded on
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obtain the correct conversion factor.
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Sampled Data ~ Calculated Data ~

. @ Data item
) Data item i .
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i@ Expression
Root path (optional)
Root path (optional)
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Start time
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A B C D E

1 |Start Time ¥
2 |End Time t
3 |Time Interval 1h

|Exprassion TagVal({"VPSD.OSIsoftPlant.PLZ.MXTK2.Flow Rate')- Flow Rate of Mixing Tank2
4 Taghvg("VPSD.OSIsoftPlant.PLZ.MXTK2.Flow Rate', "*-24h','*') Compared with the Daily
5 30-Jun-16 00:00:00 1487.533
] 30-Jun-16 01:00:00 -863.096
7 30-Jun-1602:00:00 1185.073
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